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1. Introduction

DS-Bench is a system which combines a benchmark test with evaluation of the execution result. This
DS-Bench/Test-Env  (D-Cloud) execution manual describes the system configuration and benchmark
configuration in the following four cases, and explains the operation method of DS-Bench/Test-Env (D-Cloud) in
these cases..

+ Case to run the benchmark on one physical machine

- Case to run the benchmark on one virtual machine

» Case to run the benchmark on multiple physical machines and virtual machines
+ Case to run the benchmark collaborating with D-Case Editor

This document assumes that the DS-Bench/D-Cloud environment is already setup.

Please refer to the DS-Bench/Test-Env Environment Setup Manual (DEOS-FY2013-BI-01E) for environment
setting-up.

* In subsequent sections the words ""Test-Env (D-Cloud)" are simply shown as *'D-Cloud"".
Each system name, product name, and service name in this document is the trade-mark or
registered trade-mark of the company that created the respective system, product, or service.
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2. Configuration and Environment

In this book, four cases are considered. Refer to the setup manual for installation of the package in each
environment.

2.1. Caseto run the benchmark on one physical machine

® DS-Bench Controller

Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
Sedna XML DB

® DS-Bench Target (physical machine)

Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
® D-Cloud Controller

Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1

=]
J ; DS-Bench — NetWOrk 1
J & Controller

E

D-Cloud DS-Bench
Controller Target
(physical machine)
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2.2. Case to run the benchmark on one virtual machine

® DS-Bench Controller
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
Sedna XML DB
® DS-Bench Target (virtual machine)
ubuntu-10.04-server-cloudimg-amd64 or ubuntu-12.04-server-cloudimg-amd64
® D-Cloud Controller
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
OpenStack 2011.3 (Diablo) or OpenStack 2012.1.3 (Essex)
® OpenStack Compute Node
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
OpenStack 2011.3 (Diablo) or OpenStack 2012.1.3 (Essex)

—————— Network 1

-é:: ‘ ‘ ————— Network 2
i i 4 DS-Bench @ Cloud Instance
\\ Controller

OpenStack
Compute Node

D-Cloud Controller )
+

OpenStack Controller

DS-Bench
Target
virtual machine)
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2.3. Case to run the benchmark on multiple physical machines and virtual
machines

® DS-Bench Controller
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
Sedna XML DB
® DS-Bench Target (physical machine)
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
Apache HTTP Server
® DS-Bench Target (virtual machine)
ubuntu-10.04-server-cloudimg-amd64 or ubuntu-12.04-server-cloudimg-amd64
® D-Cloud Controller + OpenStack Controller
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
OpenStack 2011.3 (Diablo) or OpenStack 2012.1.3 (Essex)
® OpenStack Compute Node
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
OpenStack 2011.3 (Diablo) or OpenStack 2012.1.3 (Essex)

4 Z “ —— Network 1
=
DS-Bench — Network 2
EEH E % Controller
K @ Cloud Instance

D-Cloud Controller
+

OpenStack Controller

OpenStack DS-Bench
Compute Node Target
(physical machine)

DS-Bench
Target
virtual machinge
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2.4. Case to run the benchmark collaborating with D-Case Editor

® DS-Bench Controller
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
Sedna XML DB
® DS-Bench Target (virtual machine)
ubuntu-10.04-server-cloudimg-amd64 or ubuntu-12.04-server-cloudimg-amd64
® D-Cloud Controller + OpenStack Controller
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
OpenStack 2011.3 (Diablo) or OpenStack 2012.1.3 (Essex)
® OpenStack Compute Node
Ubuntu Server Edition 64-bit 10.04.3 or Ubuntu Server Edition 64-bit 12.04.1
OpenStack 2011.3 (Diablo) or OpenStack 2012.1.3 (Essex)
D-Case Editor http://www.dependable-os.net/tech/D-CaseEditor/D-Case_Editor_J.html
D-Case Weaver  http://www.dependable-os.net/tech/DCaseWeaver/index_J.html
® \WebSite
Apache HTTP Server

Internet

—— Network 1

—— Network 2

@ Cloud Instance

. Operator
=i l D—Case Editor/
S DS-Bench D-Case Weaver
l T Controller

vl v\ E ,
D-Cloud Controller OpenStack WebSite

+ Compute Node

OpenStack Controller

(virtual machine
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3. Details of the Execution Procedures

3.1.Case to run the benchmark on one physical machine

Prepare the DS-Bench/Test-Env as in the configuration of Section 2.1. Register DS-Bench under the
management of D-Cloud. Here, you create / run a scenario on a DS-Bench single Target that you registered
and confirm test results.

In this case, select the "Bonnie" in the benchmark list. The performance of the server in sequential access
random access, etc. will then all be measured , and the results will be saved. The sequence of steps involved in
checking is explained below.

3.1.1. Installation of DS-Bench/D-Cloud

Install a DS-Bench controller, a D-Cloud controller, and a DS-Bench physical target. Please refer to

the "DS-Bench/Test-Env (D-Cloud) environmental setup manual® for the procedure of installation.

3.1.2. Adding a physical machine to D-Cloud

Login into the D-Cloud Controller.
Determine the location of the management file. The value of "DCLOUD_DESC_PATH" is the path to

the management file. Here, it is "/var/dcloud/config/ resource_dsb.xml".

$ cat /etc/dcloud. conf

export DCLOUD_DESC_PATH=/var/dcloud/config/resource_dsb. xml

Add the information on the DS-Bench target (physical machine) to the management file of the
D-Cloud controller.

$ vi /var/dcloud/config/resource_dsb. xml
<{dsb_resource_desc>
{target type='physical >

{/target>
{target type='physical >

</dsb_resource_desc>

Machine information is entered between <target> and </target>.
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{target type='physical >
<name>trg-tutorial</name>
<{cpu>
<arch>x86_64</arch>
<vendor>Intel</vendor>
<mode | >core2duo</mode | >
<mhz>2400</mhz>
{cores>2<{/cores>
{threads>2</threads>
</cpu>
<memory type="DDR3’ >
<{speed type="mhz' >800</speed>
<size>2048</size>
</memory>
{devices>
{device type='ethernet >
{target dev="eth0’ type="1g vendor="Intel’ model="e1000
<{/device>
{device type='storage >
<control ler type="sata’ model="ich9 ><{/control ler>
{target dev='/dev/hda’ type="sata2
priority=""/>
<{/device>
</devices>
<os>
<fami ly>Linux</family>
<vendor>ubuntu foundation</vendor>
<name>Ubuntu</name>
<version>10. 04</version>
<arch>x86_64</arch>
</os>
<{softwares>
<{software type="kernel >
<version>2. 6. 32-21-server</version>
{/software>
{software type="library’ >
<name> | ibc</name>
version>glibc2. 6. 27</version>
{/software>
{software type="package' >
<fami | y>RPM</fami ly>
{/software>
{software type='compiler >
<{lang>C</lang>
<{fami ly>GNU</fami ly>
<name>gcc</name>
version>4. 4</version>
{/software>
{/softwares>
{/target>

ip="

vendor="WesternDigital’

ip="s. % % % priority="primary />

model="Cavier Green' size="1T

Items in red in the above description are mandatory.

2013/09/01
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After "ip", specify the IP address with which communication with a DS-Bench controller and a
D-Cloud controller is possible.

Moreover, an interface whose priority is "primary" is used for communication. The information on the
target in blue letters is displayed on the following "Target detail" screen of DS-Bench. Please specify
optional items as appropriate.

*Since any item can be set up according to the user’s preference, check of the compatibility between
the specified items is not performed.

*In the case of the above-mentioned sample, the items are displayed as follows.
Target detail

cpu
arch x86_64
vendor Intel
model core2duo
mhz 2400
cores 2
threads 2
memory(DDR3)
speed(mhz) ‘ 800 ‘
devices
device(ethernet)
eth0 ‘ 1g ‘ Intel ‘ e1000 ‘

device(storage)

/dev/hda ‘ sata2 ‘ WesternDigital ‘ Cavier Green ‘ 1T
os
family Linux
vendor ubuntu foundation
name Ubuntu
version 10.04.3
arch x86_64
softwares

software(kernel)

version 2.6.32-34-server

software(library)

name libc
version glibc2.6.7?
software(package)
family RFM
software(compiler)
lang C
family GNU
name gcc
version 4.4

Close
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* The description of the minimum necessary items is as follows.

{target type='physical >
<{name>trg-tutorial</name>
{devices>
{device type='ethernet >
{target ip="*. * *x * priority="primary />
<{/device>
</devices>
{/target>

The daemons of D-Cloud are rebooted after the completion of a postscript to a management file.
The rebooting demon is "dc-resource-dsh".

$ sudo /etc/init. d/dc-resource-dsb restart

Stopping ... success
Starting ... success
$

Check that the target you have registered has been added to the target list in the DS-Bench screen.
In the case of the sample, "trg-tutorial” is displayed.
Main screen > Configuration screen > Target List

Target list

No Machine name Type Status
1 trg-tutorial physical Active

2 trgv-shutdown02-11-m1.tiny.00 virtual Power off
3 trgv-shutdown02-11-m1.tiny.01 virtual Power off
4 trgv-shutdown02-11-m1.tiny.02 virtual Power off

3.1.3. Creation of a benchmark scenario

Start up the browser, and open the main screen of the DS-Bench.

http://[The IP address or host name of a DS-Bench controller]/cgi-bin/main.cgi

(The case where the DocumentRoot that is specified during the installation of the DS-Bench controller
is the same as the Apache DocumentRoot).

Click "New Benchmark Scenario™ in the main menu.
® Synopsis ® View Result P

| VewaBerchwmrkSceramol

Load Benchmark Scenario
Benchmark Scenario Name Descript
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A scenario creation screen opens in a new window.
Click the "Add Target" button to add the target machine.

Time Scale : — 0: 2: 0o Tota
0:00 000:10:00
[ Add Target
Target list
4dd Taes | Current Tags:
Add Viewsr
Name ResultName  Description

When a dialog appears, select the machine that you added in Section 3.1.2. Here, "trg-tutorial™ is

selected.
Click the "Done™ button after choosing "trg-tutorial”.

Host :
:
J T [Bone ] Gance
A

The time line of "trg-tutorial” is displayed on the scenario creation screen.
Time Scale : — 0 2: 0 & Total : 000:20:00

0:00 000:10:00 000:20:00

l=ltrg-tutorial I

Add Target
Add Tees | Current Tags:

Add Viewer

Name ResultName  Description

= Run = Stop = New = Load u Save

Add the benchmark scenario on the timeline.
A thin orange bar is displayed when you click on the timeline. Please drag this to the right. The

dragged range becomes blue. And, please drop the bar at the point where you want to end. The start and

the end of this blue range are entered as the start time and end time in the benchmark setting dialog.
0:00

The dialog of benchmark setup is displayed after the completion of the drop.
Select "Bonnie" as the Program, specify an existing user name in the "user" box, click the "Done"
button, and adjust the parameters of the benchmark program in accordance with the environment to be

used.
Specify "Begin time" and "End time" if you want to specify in detail the how long after the scenario
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starts the benchmark starts and ends.

Target : trg-tutorial
Program : Bonnie -

Bonnie++(lI0 benchmark program)
[ClAnomaly load

Begintime: O0OH 1M 228
Endtime: OH 7M 588
Interval before starting(ms): 50
Interval after termination(ms): 1000

number of groups : 2

user: [Ee

| Done || Delete || Cancel |
e

Add the tags. Although setup of a tag is optional, a scenario execution result can be easily searched if a
tag is set.
Click the "Add Tags" button.

Strgtutorial | I

Add Target
Tarzet list
[ Add Tazs [|Current Tags:
Add Viewer
Name ResultName  Description

A dialog is displayed. Write a tag in text area, and then click the "Register" button . Two or more tags
can be specified if they are separated with a comma..
Here, "tutorial" and "physical" are registered.

Edit Tags x

Frequently used tags :
scenarioA

virtual

iperf

Bonnie

single

used tags :

tutorial physicall

|

|[ Register I[ Cancel ]
g

”Current Tags” displays the tags that have been set.
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Time Scale : — 0: 2: 0 6—
000:1

strgtutorial | R |

Add Target
Target list
[ Add Taes J|Current Tags: tutorial, physical |
Name ResultName  Description

» Run = Stop o New

The "Add Viewer" button is for setting the parameters of result values to be passed to D-Case Editor,
when the scenario is executed from D-Case Editor. Section 3.4 will explain the details.

Click the "Save" button on the screen to save the created scenario.

Description

» Run = Stop o New = Load u Save

A dialog will be displayed. Click the "Save" button after inputting a scenario name and scenario
explanation.

Here the inputted scenario name is "Tutorial01" and the inputted scenario explanation is "physical
target"”.

Benchmark Scenario Name :

Tutorial01
Description :
physical target

L | save [ Cancel ]

4

*The saved scenario can be confirmed or deleted by following the links "Main > Configuration tab >
Benchmark Scenario™.

Benchmark scenario Management

No Benchmark scenario Description
name
1 Tutorial01 physical target Delete
2 Delete
-

This completes the explanation of preparation of a scenario..
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3.1.4. Execution of a benchmark scenario

Load the scenario that you created in Section 3.1.

Click the "Load Benchmark Scenario" link in the main screen of DS-Bench.
® Synopsis ® View Result |2 C

New Benchmark Scenario

Load Benchmark Scenario

Benchmark Scenario Name Description

Tutorial01 physical target

A scenario selection dialog opens in a new window.
Choose the scenario created in Section 3.1.3 and click the "Open" button. Here, "Tutorial01" is

selected.

Benchmark Scenario Name :

:

Descriptiop :
physical taWget

I Open ” Delete H Cancel ]
4

The created scenario is loaded and displayed.

*A scenario can also be loaded by the following methods.

®  Click the scenario name under the "Load Benchmark Scenario” link on the main screen
Main screen > Scenario name

® Click the "Load" button of the benchmark creation screen
Main screen > New Benchmark Scenario > Load

® Click the scenario name on the benchmark scenario setting screen

Main screen > Configuration > Benchmark Scenario > scenario name

Click the "Run" button on the screen in order to execute the benchmark scenario.

add Tz | Current Tags: tutorial, physical
Add Wiswer
MName ResultName  Description

» Run = Stop = New w |

Below is a screen when a scenario is running.
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Time Scale : — 0: 2: o >, Total : 000:20:00
0:00 000:10:00 000:20:00

tonnie
Eltrg-tutorial - 0 = |

Name ResultName  Description
» Run  « Stop | © New = Load u Save

Uzing wid: 1115, gid:2000.
Writing a byte at a time...done
Writing intelligent lv...done
Rewriting. ..

When the run bar reaches the end of the benchmark area, the scenario has been completed.

3.1.5. Checking the results from the benchmark scenario

Upon completion of execution of a scenario, a dialog will be displayed.

Alert Dialog
tutor
@ The benchmark has been completed.
.
riptio

The results of the benchmark scenario will be shown at the bottom.

[ ome TR

» Run ‘ = Stop | = New ‘r; Load ‘ u Save

...................................................................................

Reduction ( Bonnie / %CP )

@max @min ©@sum ©prod ©avg © stddev

3
o
»
o
N

ArssEssEEEEEIEEELE

-
B e e R R Y

Reduction ( Bonnie / Rewrite )
@max ©@min ©sum © prod ©@avg © stddev

sesssrssssssslissrarasnsssrnsnnned

PrssEasaEEEEs

® Reduction result
The execution results of a benchmark program are collected, and calculations are performed.

The calculation method can be changed with a radio button.
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: Reduction ( Bonnie / %CP ) | CGalculation |:
J|[@max ©@min ©sum ©prod ©avg © stdde method :
: Calculation :
: max 97 result :

min ‘ sum ‘ prod avg ‘ stddev

Maximum | Minimum Standard
Total Product | Average o
value value deviation

Benchmark results

The execution results of a benchmark program are displayed.

The display method of benchmark results can be changed with a radio button.
Bonnie

OTable ®@Bar OLine Olog

g
. Display
Di sp | ay method L

iBonnie on trg-tutorial area

Bonnie benchmark
100 T T T T T T T

%CP
o
=1

T
1

€ Table The results are displayed in table form.
¢ Bar The results are displayed in a bar chart.
¢ Line The results are displayed in a line graph.
¢ Log Benchmark execution log is displayed.

® Register a comment
A comment on the execution result of a scenario can be registered.

Click the "Update comments" button after entering a comment in the text area.

tutorialll result

l Update comiments I
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When a comment is registered, it is displayed on the "Comment" column of a scenario execution

result list screen (View Result screen) or a scenario list screen (Synopsis screen). This list allows a

quick check of the type of scenario execution results that have been obtained.

2 Main “) Synopsis \‘) View Result “’ Configuration ‘
Search Irclude N Carenent -
1D Comment Benchmark Anormaly
Datex Machinesa Tagsa Delete
-] -] Programie Loads
108 2012/03/15 : ori tutorial01 Bonnic tutorial, physical B
98 trg-tutoria
10:15:51 ; : result
2012/03/15 hysical tutorial01,physical
195 103/ trg-tutoria phy Hackbench Py [}
09:58:29 target
o 2012/03/14 trav-shutdown01-9 cpustress —

% The methods of checking scenario execution results.
®  Scenario execution result list screen (View Result screen)
Main screen > View Result > ID
®  Scenario list screen (Synopsis screen)

Main screen > Synopsis > ID

3.2.Case to run the benchmark on one virtual machine

In the case of creating a scenario using a virtual machine and checking the results, set up a virtual
machine (image) to be used as the DS-Bench Target. Select "Memstress” from the benchmark list. This

provides a big data load in the memory area that is allocated to the target virtual machine.

3.2.1. Creation and registration of a virtual DS-Bench target

Create a virtual DS-Bench target, and register it with D-Cloud. For the procedure, refer to Section 4 of
the "DS-Bench/Test-Env (D-Cloud) Environment Construction Manual.

*The daemon of D-Cloud must be rebooted after registration is completed.

$ sudo /etc/init.d/dc-mapserver restart
Stopping success

Starting success

$

$ sudo /etc/init. d/dc-resource-dsb restart
Stopping success

Starting success

$

$ sudo /etc/init.d/dcld restart

Stopping success

Starting success

$
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Check that the target you have registered has been added to the target list linked to the DS-Bench
screen.

Main screen> Configuration screen> Target List
Target list

No Machine name Type Status
1 trg-tutorial physical Active

2 target-img-20-m1.tiny.00 virtual Power off
3 target-img-20-m1.tiny.01 virtual Power off
4 target-img-20-m1.tiny.02 virtual Power off

3.2.2. Creation of a benchmark scenario

Start up the browser, and open the main screen of the DS-Bench.

http://[IP address or Host name of DS-Bench controller]/cgi-bin/main.cgi

(in the case where the DocumentRoot that was specified during the installation of the DS-Bench
controller is the same as the Apache DocumentRoot.)

Click the main menu "New Benchmark Scenario" link

2 Synopsis 2 View Result

New Benchmark Scenario

Load Benchmark Scenario

Benchmark Scenario Name De

The scenario creation screen will open in a new window.
Click the "Add Target" button to add the target machine.
2]

lime Scale : — 0 0 -I\:/l—
0:00 000:10:
I
Add Target
|
Tarzet list
Add Tags | CUrrent Tags:
Add W iewer
Name ResultName  Descriotion

In the dialog that appears, select the machine that you added in Section 3.1.2. Here, the
"target-img-20-m1.tiny.00" is selected.
Click the "Done" button after choosing "target-img-20-m1.tiny.00".
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Host :|target-img-20-m1 tiny.00 ~
Done Cancel

The time line of " target-img-20-m1.tiny.00" is displayed on the scenario creation screen.

Time Scale : —— oz 2: o & Total : 000:20:00 | Auto Adjust |
0:00 000: 10:00 000:20:00

=ltarget-img-20- I |

m . finw.00
Add Target
Add Taze | CUrrent Tags:

Add Viewsr

Name ResultName  Description

» Run = Stop = New & Load u Save

Add the benchmark scenario on the timeline.

A thin orange bar is displayed when you click on the timeline. Drag this to the right.
0:00 0oa:

0:00 0oa0:

A dialog box for benchmark settings is displayed after dropping the bar.

Select "Memstress" as the program and adjust parameters. The memory size specified every second
(Wait = 1000000 microseconds) is secured, and this is repeated 200 times (Try count = 200) to apply a
load to the memory. Please adjust the parameters of the benchmark program in accordance with the
environment in use. Click the "Done" button after the adjustment is completed.
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Target : target-img-20-m1 tiny.00
Program : [Memstress| [v|
Memory load tool

OAnomaly load

Begintime:| 0H 1M 8&/S
End time: OH| 8M| 118
Interval before starting(ms): |0
Interval after termination{ms): |0

DEOS Project © 2013 JST

Memory size :|10240

Try count :

Wait(us) :
Delete P

The benchmark bar is displayed on the timeline.
0:00 000:1

Add the tags. Although setting a tag is optional, a scenario execution result can be easily searched with

atag.
Click the "Add Tags" button.

PIE Lol g [ ]

Add Target

Target lizt
I Add Taze | Current Tags:

1 Viewer

1g ResultName  Description

When the dialog box is displayed, enter a tag in text area and then click the "Register" button. Two or

more tags can be specified by dividing with commas. Here, "tutorial" and "virtual" are registered.
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Edit Tags x

Frequently used tags :
scenarioA

virtual

iperf

Bonnie

single

used tags :

tutorial virtual

| Register ” Cancel ]
4

The tags set as Current Tags are displayed.
Eltarget-img-20-
m1l.tiny.00

Add Tarzet
Target list

Add Tags |Currer1t Tags: tutorial,virtual |

Add Wiewer

Name ResultName  Description

Click the "Save" button on screen to save the created scenario.
it Tags: tutorial, virtual

Description

» Run = Stop © New = Load u Save

When a dialog box is displayed, input a scenario name and scenario explanation, and then click the

"Save" button.
Here, "Tutorial01" is inputted as the scenario name and "“physical target” is inputted as the scenario

Save Benchmark Scenario %

Benchmark Scenario Name :

| Tuiorial02|

Description :
Ivirtual target I

L———| save | cancel |
/

This completes the benchmark scenario creation.

explanation.
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3.2.3. Execution of a benchmark scenario

Load the scenario that you created in Section 3.2.2.
Click the "Load Benchmark Scenario" link in the main screen of DS-Bench.

> Synopsis 2 View Result P Co

New Benchmark Scenario

Load Benchmark Scenario

Benchmark Scenario Name Description
Tutorialoz virtual target
[ [ | EEE B

A scenario selection dialog opens in a new window.
Choose the scenario created in Section 3.2.3 and click the "Open" button. Here, "Tutorial02" is
selected.

Benchmark Scenario Name :

Tutorial02 -
Descriptié&
virtual targ

I Open I[ Delete ” Cancel

A

The created scenario is loaded and displayed.
*A scenario can also be loaded by the following methods.
® Click the scenario name in the window that appears after clicking the "Load Benchmark
Scenario" link on the main screen
Main screen > scenario name
® Click the "Load" button of the benchmark creation screen
Main screen > New Benchmark Scenario > Load
® Click the scenario name in benchmark scenario setting screen

Main screen > Configuration > Benchmark Scenario > scenario name

Click the "Run" button in the screen in order to perform the benchmark scenario.

—_
Add Taes | Current Tags: tutorial ,virtual
Add Viewer

Name ResultName  Description

» Run = Stop = New = L

Below is a screen showing the run state..
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Time Scale : — o0: 2: 0 & Total : 000:20:00 [ Auto Adjust |
0:00 000:10:00 000:20:00

Etarget-img-20-
m 1. tipats
000

Add Viewer

Name ResultName  Description

|> Run | = Stop = New = Load u Save

Rkt ooiobosobbioloonciioobioseoiiosooon
presrecass e ey

While executing Memstress, the number of times domains have been secured is displayed as that

number of "*" marks in the log screen.
When the vertical run bar reaches the end of the benchmark area, the scenario has been completed.

3.2.4. Checking of the results from the benchmark scenario

A dialog box will appear upon completion of execution of the scenario.

o Alert Dialog

@ The benchmark has been completed.

biufo]

un | = Stop o New = Load 0

Results of the benchmark scenario will be shown at the bottom.

‘r Run ‘ = Stop = New = Load u Save

Reduction { Memstress / terminated )

@max Omin ©sum Oprod ©avg O stddev

max 0

@ Table ©Log

Memstress on 192.168.255.4

terminated O

.

sasraay

® Reduction result
This is calculated after collecting the execution results of each benchmark program.

The display format of the calculations can be changed with a radio button.

Page 24 2013/09/01



DS-Bench/Test-Env(D-Cloud) Execution Manual
DEQOS Project © 2013 JST

................................................................................... -

: Reduction { Memstress / terminate( pa|culation

:|-I-max O min ©sum COprod ©avg O stddev method :
: Calculation ;
(el result

prod ‘ avg stddev

Maximum | Minimum Standard
Total | Product | Average o
value value deviation

® Benchmark results
The execution results of a benchmark program are displayed.
The display format of benchmark results can be changed with radio buttons.

*The graph settings available depend on the benchmark tool. "Bar" and "Line" do not appear in this

case. e FERRN 2333 FERRRe peRa

: 2 Display
EMemstress method
;f.e.rminated 0 area"" ...... i

¢ Table The results are displayed in a table form.

¢ Bar The results are displayed in a bar chart.

¢ Line The results are displayed in a line graph.

¢ Log Benchmark execution log is displayed.

® Register a comment
A comment regarding a scenario execution result can be registered.

After entering a comment in the text area, click the "Update comments™ button.

tutoriall? result

Update comments

When a comment is registered, it is displayed on the "Comment" column of a scenario execution

result list screen or a scenario list screen, so that the type of the executed scenario can be checked by
viewing the list.

2 Main |‘> Synopsis |‘> View Result |-) Configuration |
Search Include - iN Cararment -
ID Benchmark Anormaly
Dates Machinessa Comments Tagss Delete
= Programe Load=
2012403716 target-img-20- tutorial0z tutorial,virtual
266 M i =1
10:21:43 m1.tiny.00 result emstrass
2012/03/16 target-img-20- ) tutorial,virtual
261 10:03 40 M1 tiny.00 wvirtual target cpustress =1
2013/09/01
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% Methods of checking scenario execution results.
®  Scenario execution result list screen (View Result screen)
Main screen > View Result tag> ID link
®  Scenario list screen (Synopsis screen)

Main screen > Synopsis tag > ID link

3.3.Case to run the benchmark on multiple physical machines and virtual
machines

This is the case when the configuration of Section 2.1 and Section 2.2 are combined. Here, two virtual
machines are set as clients, one physical machine is set as a server and we choose benchmark "Httperf" to
perform. On the server side, Hackbench is used as Anomaly Load.

Each virtual client accesses the physical machine which is set up with Anomaly Load 2 times/second,
until the total number of accesses is 200. We monitor and record the response time after these accesses.

A schematic view of this environment is as follows.

Server trg-tutorial (physical machine)
Clientl target-img02-21.m1.tiny.00 (virtual machine)
Client2 target-img03-22.m1.tiny.00 (virtual machine)
Hackbench
(Anomaly Load)

Web Server

trg-tutorial (physical machine)

Client Client

Target-img02-21.m1.tiny.00 Target-img03-22.m1.tiny.00

(virtual machine) (virtual machine)
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3.3.1. Advance preparation

Add the (virtual) DS-Bench target to be used as a client.
Login to the server in which OpenStack is installed.

$ cd /var/noval/images/test/

$ pwd

/var/noval/images/test/

$

$lsI

total 1991356

-rw-r—r—— 1 root root 1476395008 YYYY-MM-DD hh:mi lucid-server—cloudimg-amd64. img

-rw-rw-rw— 1 root root 4110432 YYYY-MM-DD hh:mi lucid-server—cloudimg—amd64-vmlinuz-virtual
-rw-r——r—— 1 root root 1476395008 YYYY-MM-DD hh:mi target-img

$

The display then moves to the directory where i the virtual target image was saved as described in Section

3.2.1. In this case; this is "/var/nova/images/test".

Copy the "target-img"

$ sudo cp —p target—img target-img—02

$

$ls I

total 2986876

-rw-r—r—— 1 root root 1476395008 YYYY-MM-DD hh:mi lucid-server—cloudimg-amd64. img

-rw-rw-rw- 1 root root 4110432 YYYY-MM-DD hh:mi lucid-server—cloudimg-amd64-vml|inuz-virtual
-rw-r—r—— 1 root root 1476395008 YYYY-MM-DD hh:mi target-img

-rw-r—r—— 1 root root 1476395008 YYYY-MM-DD hh:mi target-img—02

$

Register in OpenStack the image you copied. In the same way, the kernel used is "org-kernel"

$ sudo nova-manage image image_register target—-img—02 admin ——name=target-img02 ——kerne|=00000001
—-—cont_format=ami —-disk_format=ami

Image registered to 21 (00000015).

$

Registration is checked.

$ glance index

ID Name Disk Format Container Format Size

21 target—img02 ami ami 1476395008
20 target—img ami ami 1476395008
1 org-kernel aki aki 4108960
$
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Register "target-img-03" in the same way. Check after registration.

$ glance index

ID Name Disk Format Container Format Size

22 target—img03 ami ami 1476395008

21 target—img02 ami ami 1476395008

20 target—img ami ami 1476395008

1 org-kernel aki aki 4108960

$

Reboot the demon of D-Cloud after the completion of registration.

$ sudo /etc/init. d/dc-mapserver restart
Stopping ... success

Starting ... success

$

$ sudo /etc/init.d/dc-resource-dsb restart
Stopping ... success

Starting ... success

$

$ sudo /etc/init.d/dcld restart
Stopping ... success

Starting ... success

$

In the DS-Bench screen, check the DS-Bench targets (virtual) which are registered.

Main screen > Configuration screen > Target lists

Target list

No Machine name Type Status
1 trg-tutorial physical Active

2 target-img03-22-m1.tiny.00 virtual Powar off
3 target-img03-22-m1.tiny.01 virtual Powar off
4 target-img03-22-m1.tiny.02 virtual Power off
5 target-img02-21-m1.tiny.00 virtual Power off
s} target-img02-21-m1.tiny.01 virtual Power off
7 target-img02-21-m1.tny.02 virtual Power off
2 target-img-20-m1.tiny.00 virtual Power off
9 target-img-20-m1.tiny.01 virtual Powar off
10 target-img-20-m1.tiny.02 virtual Power off

Next, check whether the Apache has started on the physical machine used as a server.

Log into the physical machine and check whether some processes have started.
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*If Apache is not installed in the DS-Bench target (physical machine), install it now.

$ ps —ef | grep apache

root 1905 1 0 MMMDD ? 00:00:06 /usr/sbin/apache?2 -k start
www—-data 1907 1905 O MMMDD ? 00:00:04 /usr/sbin/apache2 -k start
www—data 1909 1905 O MMMDD ? 00:00:04 /usr/sbin/apache?2 -k start
www—-data 1911 1905 O MMMDD ? 00:00:04 /usr/sbin/apache2 -k start
fkrkkrk 8985 7025 0 hhimi pts/0 00:00:00 grep apache

$

Check whether "index.html" specified at the time of httperf execution exists in DocumentRoot.

$ Is =1 /var/www/index. html
-rw—-r——r— 1 root root 177 YYYY-MM-DD hh:mi /var/www/index. html
$

3.3.2. Creation of a benchmark scenario

Start up the browser, and open the main screen of the DS-Bench.
http://[The IP address or host name of a DS-Bench controller]/cgi-bin/main.cgi
(In the case where the DocumentRoot specified during the installation of the DS-Bench controller is
the same as the Apache DocumentRoot).
Click the "New Benchmark Scenario™ link of the main menu.
|'7* Synopsis \"' View Result |'> Co

New Benchmark Scenario

Load Benchmark Scenario

Benchmark Scenario Name Description

A scenario creation screen opens in a new window.

Click the "Add Target" button to add the target machine.
Time Scale : — o0 : 2: 0

P

0:00

Add Tarest |

Add Tazs | Current Tags:
Add Viewer
Name Resnlthame Nescrintinn

In the dialog box that is displayed, select the physical machine used as the server. Here, "trg-tutorial” is
selected.

2013/09/01 Page 29



DS-Bench/Test-Env(D-Cloud) Execution Manual

© 2013 JST

The "Done" button is clicked after choosing "trg-tutorial".

Host :

:
) \I Done " Cancel ]
A

The time line of "trg-tutorial™ is displayed on a scenario creation screen.
Time Scale : — ot 21 0o B Total : 000:20:00 [ autn Adjst |

0:00 000:10:00 000:20:00

=trg-tutorial I | ‘

Add Target
Add Tags | Current Tags:

Add Viewer

Name ResultName  Description

» Run = Stop = New & Load u Save

In the same way, add two virtual machines which will become clients.

After adding, the scenario creation screen will show the following.

Time Scale : —— o 2: 0 £ Total : 000:20:00
000 000: 10:00 000320:00

=ltrg-tutorial I ‘

Eltarget- I ‘

imgi2-21-

[Edjiy A ] I ‘

img03-22-

) 0:00 000:10:00 000420:00

Add Target
Current Tags:
Name ResultName  Description

» Run = Stop = New & Load w Save

Add a benchmark program, as follows.
First, add "httperf" to a virtual machine.
Drag-and-drop on the time line of one of virtual machines.

Btarget- [

imgo2-21-

Btarget- [ BN |

imgoZ2-21-

DEOS Project
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A dialog for benchmark settings is displayed.
Select "httperf" as the Program. Enter the start time"OH OM 0S", end time"0H 2M 0S", total number of
connections"$(param:Total Number of Connections {tconn0}:200)", the number of accesses per
second"$(param:Connection Rate {rate0}:2)", the destination server, and the reference URL (the URL
of the index.html confirmed in Section 3.3.1). Create a scenario to perform the connection 200 times, 2
times per second, to the Web server, and click the "Done" button.

| 0

Target : target-img02-21-m1 tiny.00
Program : -
Httperf

[ Anomaly load

Begintme: O0OH OM 083
End time: 0O0H 2M 08
Interval before staring(ms): 15
Interval after termination{ms): 37

Total Number of

Connections : ons
Connection Rate : in Rate
Connection I:I
server

URI :}/index.html

Port number: 80

V3

Add “httperf” on another virtual machine.
*Since a parameter which starts with "$ (param-)" is for changing a value when executing from

D-Case editor, please use the default value here as is. Please refer to Section 3.4.1 for an explanation.

0:00 000:10:00 000:20:00

Eltrg-tutorial I ‘

ltarget- P ‘
img02-21- ‘
m1.tiny.00

Etarget- P ‘
img03-22- ‘

m1.tiny.00

0:00 000:10:00 000:20:00

Next, in order to generate a load on the server side, add "Hackbench" to the physical machine
"trg-tutorial”. Drag-and-drop on the time line of the physical machine.

When the dialog box of benchmark setup is displayed, select the following items.

Select "Hackbench" as the Program, check Anomaly load. Enter the Start time"0H OM 20S", end time
"0H 2M 0S", and the magnitude of the load "480", and click the "Done" button.
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Target : trg-futorial

Program : v
Hackbench(Load test)

[Janomaly 10ad

ngntime: OH OM 208
End time: OH 1M 408
Interval before stading(ms). 15
Interval after termination(ms): 37

number of groups

Y

After these additions, the scenario screen is as above.
When the scale of the time line is not correct, it self-adjusts
Click the "Auto Adjust" button.

Time Scale : — 0: 2: 0 B—Tota\ :OOO:ZO:OO

0:00 000:10:00 000:20:00

=ltrg-tutorial I:w
lzltargat- P
img02-21-

m1.tiny.00
=ltarget- P
img03-22-

m1.tiny.00

0:00 000:10:00 000:20:00

Because the scale is adjusted automatically, it becomes easier to understand.

0:00 000:01:15 000:02:30

rrgwrona ||

target- _:
imgoz2-21-
ml.tiny.00
target- _:
imgo3-22-

m1.tiny.00

0:00 000:01:15 000:02:30

Add the tags. Click the "Add Tags" button.

HTYUS-2£-
m1.tiny.00

Add Target

Target list
[ Add Tazs | Current Tags:

Add Wiewer

Name ResultName  Description

0:00

DEOS Project

When a dialog box is displayed, enter "tutorial”, "physical" and "virtual™ here. After entering, please

click the "Register" button.
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Edit Tags x

Frequently used tags :
scenarioA

virtual
iperf
Bonnie
single

used tags :
| tutorial physical ,virtuaIJ

|| Register H Cancel ]
A

A tag is added to the scenario creation screen.
Target list

Current Tagsltutorialxphysicalivirtual I

The scenario creation screen after the completion of the input is shown below.

Time Scale : —— o0: 0: 15 Total : 000:02:30
0:00 000:01: 15 000:02:30

Hackberch
=trg-tutorial : o |

img02-21-
L=l taimat 00
img03-22-
m1.tinv.00

Add Tarzet
Add Tags | Current Tags: tutorial,physical virtual

Add Viewer

Name ResultName  Description

Httperf

0:00 000:01:15 000:02:30

Save the created scenario.
Click the "Save" button. Since a dialog is displayed, enter the scenario name "Tutorial03", "physical
and virtual target" in the description and click the "Save™ button.

Save Benchmark Scenario *®

Benchmark Scenario Name :

| |Tutoria|03|

Description :
I physical and virtual target

Save_l Cancel
%J

2013/09/01 Page 33



DS-Bench/Test-Env(D-Cloud) Execution Manual

© 2013 JST DEOS Project

This completes the benchmark scenario creation.

3.3.3. Execution of a benchmark scenario
Load the scenario created in Section 3.3.2
Click the "Load Benchmark Scenario" link in the main screen of DS-Bench.
2 Synopsis 2 View Result

New Benchmark Scenario

Load Benchmark Scenario

Benchmark Scenario Name Des

Tutorial03 physical and virtual target

A scenario selection dialog opens in a new window.

Please choose the "Tutorial03" scenario and click the "Open™ button.

Benchmark Scenario Name :

Tutorial03 -

Descriptiog :
physical arvirtual target

| Open “ Delete H Cancel ]
4

The created scenario is loaded and displayed.
*A scenario can also be loaded by the following methods.
® Click the scenario name under the "Load Benchmark Scenario" link on the main screen
Main screen > scenario name
® Click the "Load" button of a benchmark creation screen.
Main screen > New Benchmark Scenario > Load
® Click the scenario name in the benchmark scenario setting screen.
Main screen > Configuration > Benchmark Scenario > Scenario Name
Click the "Run" button on the screen in order to perform the benchmark scenario.

* Add Viewer is explained as it is used together with D-Case Editor which is explained below.

Add Viewer
Name ResultName  Description
= Tutorial-result rraxHttperf Ttotal) max of laatency

» Run = Stop = N
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Below is the screen in a run state.
Time Scale : ——- o : 0: 15 = Total : 000:02:30 [ Auto Adust |

0:00 000:01:15 000:02:30

X Hackbench
=ltrg-tutorial - |

=ltarget-

imgo2-21-
L=ltaEmat 0
imgO03-22-

A Ehiéo

Add Target
Add Tags | CUIM

Add Viewer

Name ResultMame  Description

=) Tutorial-result FlreductionmaxHtt max of laatency

= Run = Stop o New &= Load

éht’(perf -—client=0/1 --server=172.16.128.135 --port=80 - §
D--uriz/index.html --rate=? --send-buffer=4096 --recv-buffer=16384 [1:
t-mrum-corns =200 --num-cal ls=1 --conn-stats=- :
DMaximum connect burst length: 0 §
§ id Lport  Result Tstart Tconn  Ttotal

0 -1 SUCCEEDED 0.0 0.7 1.6

* 1 1 [a N i e [~ s Ta T n 7 1 &

When the run bar reaches the end of the benchmark area, the scenario has been completed.

3.3.4. Checking the results from the benchmark scenario

Upon completion of execution of a scenario, a dialog box will appear.

Alert Dialog
tutor]
@ The benchmark has been completed.
-
riptio

Results of the benchmark scenario V\{i” be shown at the bottom.

Reduction { Httperf / Ttotal )

©max ©min ©sum ©prod ©avg O stddev

max 599.9

Reduction { Httperf / Tstart )

Omax Omin ©sum ©prod ©avg O stddev

max 995 10.8

O Table @Bar ©Lline ©Log

Httperfon #0 mw = &

Httpert benchmark

ST e

® Reduction result

2013/09/01 Page 35



DS-Bench/Test-Env(D-Cloud) Execution Manual
© 2013 JST DEOS Project
This is calculated after collecting the execution results of each benchmark program.

The calculation display format can be changed with radio buttons.
In the following cases, the maximum response time of "httperf" is displayed as "599.9 milliseconds".

: Reduction { Httperf / Ttotal ) Caloulation |
@max Omin ©@sum ©prod ©avg © stddev< method
Calculation
imax 599.9 result

prod ‘ avg

Maximum | Minimum standard
Total | Product | Average o
value value deviation

® Benchmark results
The execution results of a benchmark program are displayed.
The display format of benchmark results can be changed with radio buttons.
As seen in the following graphs, load occurs 20 seconds after the start of the server, and it can be

confirmed that the response is late.

Httpert
L . SR
Table @Bar ©Lline ©Lo :
: Display
iHttnerf an target-img03-22-m1.tiny.00 method
: Display :
i area Httperf benchmark H
T
300 -
250 | .
T 200 - R
[=]
E 150 .
100 | i
50 |
: O | 1 L 1 1 :
H 0100@D0ED0AD0 o 0
: Tstan It is appoint where 20
OO TT T TRUTTSTERRRRRT seconds have passed
Httperf

Table @Bar ©Line ©Log

Httperf on target-img02-21-m1.tiny.00

Hitperf benchmark

600 T T T T T T T T T
Bar

500 -1

400 R
™
o 300 -1
= g

200 . :

100 R :

0 1 1 | 1 ! L N = N
0100800G0080080 It is appoint where 20
Tstart seconds have passed
L e 4
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® Registering a comment
A comment regarding the execution result of a scenario can be registered.
Enter a comment in the text area, and click the "Update comments™ button .

|tutoria|03 result I

| Update comments

When a comment is registered, it is displayed in the "Comment" column of a scenario execution
result list screen (View Result screen) or a scenario list screen (Synopsis screen) , so that what kinds of
scenario have been executed can be easily checked from the list.

# Main "’ Synopsis |" View Result "’ Configuration ‘
Search Tncluds = in Gomment =
ID Machines Benchmark Anormaly
Dates Commentsl Tagsel Delete
-] -] Programs Loada
trg-tutorial
target-
imgoz-21-
2012/03/23 tut l,ph |, virtual
459 10_5;_44’: mitiny00 | tutorial03 result Httperf Hackbench a PRYSIEALAITTIA [}
T target-
imgo3-22-
m1.tiny.00
453 &)
— [aa |

#%  Method of checking scenario execution results
®  Scenario execution result list screen (View Result screen)
Main screen > View Result > ID
®  Scenario list screen (Synopsis screen)
Main screen > Synopsis> ID

3.4.Case to run the benchmark collaborating with D-Case Editor

Please refer to http://www.dependable-os.net/osddeos/en/concept.html regarding D-Case. Regarding

D-Case Editor, refer to http://www.dependable-0s.net/tech/D-CaseEditor/index-e.html . Regarding D-Case
Weaver, refer to the http://www.dependable-os.net/tech/DCaseWeaver/index-e.html .

When it is required that the measurement results of the Benchmark be set into Evidence Nodes at the time
of D-Case creation, this configuration is created using D-Case Editor or D-Case Weaver.

As an example, it will here be verified whether at "response time is less than three seconds if the number
of accesses to a Web server is less 1500 times a minute".

The configuration used here is that of Section 2.4: a D-Cloud controller +OpenStack controller, a Web
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server, and the DS-Bench target (virtual machine) created in Section 3.2.
Create a DS-Bench scenario in order to verify the example scenario described above.
A virtual machine is set as the client, and “httperf” in which a web site is the server benchmark is used.
The scenario created by the D-Case editor is loaded. The expected value "the maximum response time is
less than 3 seconds" is set up as a goal node.

*Install Apache on a Web server and check that "index.html" file is in the "/var/www/" folder.

3.4.1. Creation of a benchmark new scenario

In order to verify, create a scenario which accesses the Web server 1500 times per minute and measures
each response time. .

Click the "New Benchmark Scenario™ link of a main menu.
\-')' Synopsis \-')' View Result \-')' Co

New Benchmark Scenario

Load Benchmark Scenario

Benchmark Scenario Name Description

A scenario creation screen opens in a new window.
Click the "Add Target" button to add the target machine.

Time Scale : — o 2/ o @&
0:00
[ Add Tarzet |
Add Tazs | Current Tags:
Add Viewer
Name ResultNamea Neacrrintinn

In the dialog box that is displayed, select the virtual machine to be used as the client. Here,
"target-img-20-m1.00" is selected.
Click the "Done" button after choosing "Target-img-20-m1.00".

Host :|target-img-20-m1 tiny.00 ~
Done Cancel

The time line of " target-img-20-m1.00" is displayed on a scenario creation screen. Drag-and-drop

virtual machines on the time line.
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Time Scale : —A 0: 2: o0

Total : 000:20:00

0:00 000; 10:00 000: 20; 00
=target-img-20- I |
mi.tinw. 00
Add Target
Add Taze | Current Tags:

ver

A dialog box for benchmark settings is displayed.

¢ ]

Select "httperf" as the Program. Set the start time and the end time.

Enter the total number of connections"$(param:Total Number of Connections {tconn0}:1500)", the
number of accesses per second"$(param:Connection Rate {rate0}:25)", the destination server, the
reference URL (URL of the index.html identified in Section 3.3.1). Click the "Done" button.

*Set an IP address in "Connection server".

Jeilal

Target : target-img-20-m1.tiny.00
Program {| Httperf - ||
Httperf

T Anomaly load

Begintime:| O/H| OM| 0S
End time: OH| 1 M| 20S
Interval before starting(ms): |15
Interval after termination(ms): |37

Total Number of -
. : nnectlons}llSOOi
Connections

Connection Rate : zctionParSec

Connection server : |Web site

URI : Vindex.html

Port number: |80

| Done | | Delete || Cancel |

4
*[ A parameter which starts with "$ (param-)" is for changing a value when executing from a D-Case
editor. Input rules are as follows.

$(param:[Description]{[variable name]}:[value])

® [Description] It is a description of the variable name. Specify any value.
® [variable name] The variable name that appears in the D-Case Editor. Please specify a
value that is unique within the scenario.

® [value] The value to be assigned to a variable. Specify the suitable value in your
environment.
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Set the expected value obtained by executing the order so as to determine if the response is less than 3
seconds in D-Case Editor.
Click the "Add Viewer" button.

Three text boxes are displayed on a scenario creation screen. Input a value into each box.
| AddTags | Current Tags:

| Add Viewer |
Name esultName  Description
=l|Response Time(ms) S(reduction:max:Httperf:Total) | max of latency
® Name Input a variable name. Here, "Response Time (ms)" is inputted.
® Result Name The value of the variable is set. Input rules are as follows.

$(reduction:[mathmatical operation method]:[ benchmark program name]:[ label name])
Since the maximum of the reduction results of Httperf is acquired here, the input is as follows.
$(reduction:max:Httperf: Ttotal)
*The label name "Ttotal" is a variable, the value resulting from reduction of response time.
(The following value resulting from reduction is the label name)
Reduction { Httperf /

é-@-max Omin ©sum Oprod ©avg O stddev

{ max 820.8

.
!o%';';%';';%';';%';';%';';%';';'-';';'-';';'-';';'-';';'-';';'-';';'-';';'-';';'-';';'-';';'-';%'o';%'o';%'o';%'o';%'o';%'o';%’o’;%’o’;%’o’;%’o’;%’; 1
.

: Reduction { Htkperf / Tstart )

é-@-max Omin ©sum Oprod ©avg O stddev

Besssrsnssnssnssnsand

® Description The description of a variable is inputted. Here, "max of latency" is inputted.
Click the "Save" button on screen to save the created scenario. In the dialog that is displayed,
enter the scenario name “Tutorial04”, and enter the explanatory note ”Benchmark by Htgtperf.
This Benchmark accesses the Web server {ConnectionPerSec} times a second until the number
of accesses reaches{TotalConnections}. Input “Evaluate whether the expected value ({Response
Time(ms)}[ms]) is fulfilled or not”, and click the "Save" button.

Benchmark Scenario Name :

[Tutorialo4 |
Description :
Benchmark by Httperf.This
| Save || Cancel |
A
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The explanatory note (Description) specified here is displayed as explanation of the Goal node when a

scenario is called by the D-Case.

If the variable name set up by "(param: description {[variable name]}: [value])" at the time of scenario

creation is entered in an explanatory note enclosed by {3}, it’s called-up state will not be the variable name

but rather the value.

This completes the creation of this scenario.

3.4.2.

Make the preparation for running a benchmark scenario from D-Case Editor.

Creation of a New D-Case diagram

Start Eclipse, select "File> New> Other" from the menu.

= Jlava - Eclipse

Edit Source Refactor Mavigate Search Project Run D-Case Window Help
ey Alt+Shift+ N » | (2% Java Project
Open File... 9 Project..

Close Ctrl+w | #F  Package
Close all Ctrl+ Shift+w | & Class
Save Ctrl+5 @ Interface
v i
Save As... &% Source Folder
Save All Ctrl+ Shift+8 @ | Enum
Revert @ Annotation
151 Java Working Set
P E7 Unit Test Case
Renarme... Fz & Task
&1 Refresh F5 | & Untitled Text File
Convert Line Delimiters To 3 % Folder
Print... ctri+p | [§ File
Switch Workspace v B9 Example..
FRSSEIE [[c5 other. ceri+n |
g2y Import...
5 Export..

Select the "D-Case Editor> D-Case Diagram" and click the "next" button
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= New (o o
Select a wizard p—

Creates D-Case diagram.

Wizards:

type filter text

> = General -
= CVS

4 [= D-Case Editor

- = Gt

= Java

s = Maven

» = Tasks
> (= WindowBuilder

m

@:I = Back

Mext = ]l Finigh Cancel

Here, a new file will be created in the "D-CaseTemplate™ folder.
Select the DS-Bench5 folder. Select a diagram name and add the extension ".dcase_diagram”. Here, this

is "Tutorial04.dcase_diagram". Click the "Next" button.
= MNew D-Case Diagram [ ===

Create D-Case Diagram

I

Select file that will contain diagram model.

Enter or select the parent folder:

D-CaseTermplate

=

=% D-CaseTemplate

File name: I TutoriaIU4.dcase_d\agram||

I Advanced == ]

= Back I et = ” Finigh Cancel

)

A model name is specified.

Since the model name is inputted automatically, the Finish button can then be clicked.
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A D-Case diagram has been newly created.
< Java - D-CaseTemnplate/Tutorial04. dease_diagram - Edlipse ==
File Edit Diagram Mavigate Search Project Run D-Case Window Help
i@ & B0~ HE- SO s E v e D 5 [{ava)
9

Tahoma |A~ B~ s> -~ |@|B~-B~% -7 ~ | 100% -

[# PackageE i3 = B[ i) Tutorialo4.dease_diagram i3 =g
=R | N KRR ERRRCR: RN TRREIRRE) IR ARR CIRAKRE ¢ AIARRR T4 v e D6 v A8 roai e Q0 e e 22 ceen s 24 % paletie >

> D-CaseTemplate NECEE

(= GSM Nodes <
Bgeal
O Evidence
I Strategy
O context

(Dustisication
(= D-Case Nodes «

m Monitor

[El Systern

B policy

M userdefool

MW seriefong
(= Links ©

K, Supported By
= R, In Context Of

[£1 Problems | @ Javadoc ([, Declaration | =] tammiet | El Console 32 [ Properties| &) Error Log a *-=0

Mo cansoles to display at this time.

3.4.3. Setting up cooperation with DS-Bench

Set up cooperation with DS-Bench as follows.

"Window > Preferences" is chosen from a menu.
se_diagram - Eclipse

Project Run D-Case Help

Ty BHE- @ Meare Windome .
| - - - New Editor
1104, dease_diagram &2 Open Perspective 3
SR d Show View v [1z

Customize Perspective...
Save Perspective As...
Fieset Perspective...
Close Perspective

Close All Perspectives

Mawvigatioh »

I Preferences I

Select "D-Case Diagram > DS-Bench Servers".
Set up DS-Bench.
Click the "Add" button after the completion of setting.
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= Preferences =R R (™=
type filter text DS-Bench Servers M v

General
Ant
D-Case Diagram

Appearance
Bookimarks
Connections
Converters

| DS-Bench Servers ||
Parameters

Printing
Rulers And Grid
Help All Scenario URL: fegi-binfget_scenario_list.cqi

Server Mamme. Tutorial Server

Install/Update Detail Scenario URL: |fegi-binfget_scenario_detail.cqi
Java

Maven Execute URL: fegi-binfrun_scenario. cqi
Madel Validation Maonitor and Search URL: fegi-bin/get_state_result.cgi
Mylyn Cancel URL: [eqi-hingstop_scenario.cqi
Run/Debug
Teamn
Usage Data Collector Result view URL: ,"cgi-bin;‘viam_result_detail.cg‘
Walidation
WindowBuilder

XML l

Scenario wiew URL: Jeqi-hingview_scenario.cgi

Add [Delete]

Restore Defaults ] l Apply I

@j oK [ Cancel l

Server Name

Specify any name you desire. It will be the DS-Bench server name in the D-Case Editor.
All Scenario URL

This is the URL to get the scenario list from DS-Bench.

http:// [IP address or Host name of DS-Bench controller]/cgi-bin/get_scenario_list.cgi
Detail Scenario URL

This is the URL to get detailed scenario information from DS-Bench.

http://[IP address or Host name of DS-Bench controller]/cgi-bin/get_scenario_detail.cgi
Execute URL

This is the URL used to run a scenario from D-Case Editor.

http://[IP address or Host name of DS-Bench controller] /cgi-bin /run_scenario.cgi
Monitor and Search URL

This is the URL used to get the scenario execution status from DS-Bench.

http://[IP address or Host name of DS-Bench controller] /cgi-bin /get_state_result.cgi
Cancel URL

This is the URL for stopping the scenario from D-Case Editor.
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http://[IP address or Host name of DS-Bench controller] /cgi-bin /stop_scenario.cgi
Scenario View URL

This is the URL to get the scenario execution results from DS-Bench.

http://[IP address or Host name of DS-Bench controller] /cgi-bin /view_scenario.cgi
Result View URL

This is the URL to view the scenario execution result screen of DS-Bench.

http://[IP address or Host name of DS-Bench controller] /cgi-bin /view_result_detail.cgi

The DS-Bench server name that has been set is displayed in the top area.
After checking the display, click the OK button.

3.4.4. Importing a benchmark scenario

The scenario of DS-Bench is imported from Strategy of D-Case Editor.

- o B s e Qavecrcces |

| test.dcase_diagram *demo.dcase_diagram 2 =

B0 86 a i e gege - | G palette
. & -
= GSN Nodes
O Goal
OEvidence
&F strategy
O Context
O GoalG_100 (@ Justification
EIGoal:IG_BEi Can detect SLA violaatic & Assumption
w Can satisfy SLA . € Undeveloped

l B ModuEe

- i strategy:s_40
- Argue over benchmarks

& strategy:s_39
Argue over SLA

A Strategy:S_26

Divide into Monitors
and Actions

[= D-Case Nodes
i Monitor
[Elsystem
& policy

O Goal:G_68 ‘ M userdefoo1

10

12

M userdefo02
W userdefoo3

Access counts can be monitored
& Links
I Supported B

() Monitor:M_11
Monitor at the entrv k...
K In Conktext O

\:n ™\ Link

=

T T B

Acquire the list of benchmark scenarios.
Follow the links "Right-click the Strategy > DS-Bench> Select Test Scenario> [Server Name set as
described in Section 3.4.2] "
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ate Searc File >

Edit >

Delete from Model

E *d Format >
LR Add child sl
Convert Node Type ” itrategy:s_39
Attachment > Ue over SLA = GSN Nodes @
showj/Hide Children > O Goal
set sibling Order O Evidence
Parameters > O Goal:G_100 & strategy
Select subtree CandetectSLAv| O Context
E | and respond it I | I
. FSSUTTTELION
I & stra Show Properties View i strategys. 2| € Undeveloped
[/ o s ot oo
=D-Case Nodes @
Input Methods /) i Monitor
O Goal:G_68 [Elsystem
Access counts can be monitored g Policy
M userdefoo1
M userdefoo2
M userdefoo3
Monitor at the entrv k...
= Links @

A scenario list is displayed in the lower part of the screen.

3.4.5. The addition of a Goal node (import of a benchmark scenario)

The scenario created by DS-Bench is imported to a D-Case editor.

Choose the scenario to execute from a scenario list and click the "Import" button.

Here, "Tutorial04" created in Chapter 3.3.2 is chosen.

[Zi Problems @ Javadoc [& Declaration E Console = TutorialServer &3 | & Properties Impurnariu = 8
Scenario ID Scenario Name Description
id_0000000174 bonnie sample scenario

-~
id_0000000163 anomaly-test The test scenario of the anomaly load which uses hackbench For a demo-httperf scenario as an anomaly loa
id_0000000170 test test

A Goal node is added on canvas.

L

O Goal:G_99
Can satisfy SLA

)

A strategy:5_40
Argue over benchmarks

O Goal:G_102

Benchmark by HttperfThis benchmark accesses
the Web server 42 times a second until the
number of accesses reaches 2500.1t evaluates
whether expected value({ResponseTime(ms)}
[ms]) is Full filled or not.
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Specify the parameters of the scenario set in the DS-Bench.
Follow the links "Right-click the Goal pugde> DS-Bench> Set Parameters ..."

“I

=]

g~ - - R gra lAccess 5 | |&Ja
| Delete from Model E
il i = &
m *demo.dcase_diagram = | Format >
A0 B 6 A Add child )'—6”“7“?31?“8 |
Convert Node Type > 7@& =SUw
Attachment > - & GSN Nodes
____— show/Hide children — DBgoal
oal:G_1 Oy
OGoalG_99 Parameters > | datec Evidence
Can satisfy SLA Select subtree respol &F Strategy
o
Redmine > Gonkeyk
o = D-Case Nodes
A strategy:s 40 D-Case DB £heab
Argue over benchmarks l—
: . Execute
?how Properties View - ® Policy
p— e M userdefond
Benchmark by HttperfThis benchmark acc emove from Contex +CLri+AlL+ = Links
the Web server 42 times a second until the W, Supported B
number of accesses reaches 2500,k evaluz _INPUL Methods > PP Y
whether expected value({ResponseTime(ms)} K In Context OF
[ms]) is Full filled or not. \ Link
(i Monitor:M_11 o, Lk
-adoc Declaration = Console O Tutorial Server £2 Properties Import Openscenaric = C
enario Name | Description
mnnie sample scenario

Benchmark by Httperf.This benchmark accesses the Web server {ConnectionParSec} times a second until
The test scenario of the anomaly load which uses hackbench For a demo-httperf scenario as an anomaly lc

iomaly-test

In the dialog box of parameter setup that is displayed, specify each parameter.

Click the OK button after parameter specification.
The expected value of maximum response time (variable name: Response Time (ms)) of httperf is set at

(<3000 millisecond) 3 seconds in the created "Tutorial04" scenario.
* Comparison operators such as "less than" and "not less than" are input with symbols such as

ll>llandll>:ll.

Benchmark by Httperf.This benchmiark actwh server {ConnectionParSec} times a second until the number of accesses reaches {TotalConnections}.It evaluates whether expected value({ResponseTime(ms)}[ms]) is Full filled or nol

TotalConnections : IZSDO

ConnectionParSec : [42

ResponseTime(ms) : [<3000]

Benchmark by Httperf.This benchmark

TotalConneckions : [2500

ConnectionParSec: |42

ResponseTime(ms): [-:3000|

2013/09/01
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Confirm the set of parameters.
Follow the links "Right-click the Goal node > Show Properties View".

{2/ Problems @ Javadoc [Z Declaration E Console T Tutorial Server = Properties 52 g A |
O Goal
Core Property Value
Appearance =
Desc = Benchmark by Httperf.This benchmark accesses the Web server 42 times a second un
Desc Format String = Benchmark by Httperf.This benchmark accesses the Web server {ConnectionParSec} t
Message =
Name =G 102
Parameters I= TotalConnections=2500,ConnectionParSec=42,ResponseTime(ms)=<3000
Project I= project:DS-Bench,server:Tutorial Server,scenario:demo-httperf
Requirement =
Score =0
Script =

A property is displayed in the lower part of the screen.
Check that the parameters set as “Parameters” are displayed.

3.4.6. Execution of a benchmark scenario

Execute a benchmark scenario from a D-Case editor.
Follow the links "Right-click the Goal node > DS-Bench > Execute".

AL I T > :
>~ — = .&‘. ~ O [Q l E
Delete from Model E
m *demo.dcase_diagn o mat >
A0 B e )_-4---"""2“'2:Palettt
—|[[s &, &)
« Convert Node Type > O Goal:G_1 ks ® &
OGoalG, Attachment > Can detect = GSN Nt
Cansatist  show/Hide Children > andrespor D Goal
Parameters > © Evide
& strat
& strateqys. Select subtree ...Stra.te l
Argue overbe  Redmine 5 Dl\élcf Ln Conkt
— and Actic
D-Case DB > | & D-Case
x ! Set Parameters...  Moni
O Goal:G_102 h . . || ske
Benchmark by HttperfThis Show Properties View Polic
the Web server 42 times a ¢ ﬂ :
number of accesses reache: W user
whether expected value({R =
[ms]) is Full filled or not. & Links
Input Methods I > K Supp
Monitor at the entrv ... K. InCo
™ Link

The dialog box which asks whether to execute monitoring is displayed.
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Click the 'OK" button to carry out the monitoring.

A log is displayed on the lower part of the screen during execution. Moreover, the progress ratio is
displayed in a Goal node.

test.dcase_diagram *demo.dcase_diagram 2
.4"""'—‘I?_"""'—‘IO"""'—8""""'—6 I SR NI SIS

L

- A Strategy:s_40
. Argue over benchmarks

o

: O Goal:G_102 -
o Benchmark by HttperfThis benchmark accesses O Goal:G_68

. 1 the Web server 42 times a second until the I e R
- number of accesses reaches 2500.0t evaluate...

- |run 35 %I

=T

- () Monitor:M_11

- Monitor at the entrv t...

o

@

Problems Javadoc Declaration B Console &2 Tutorial Server Properties

Console

2013/05/24 11:27:49 net.dependableos. dcase. diagram ##% update status process end. #*¥%
net.dependableos. dcase. diagram **% update status process start. #%x
net.dependableos.dcase. diagram Benchmark status(3) progress(35) Goal(G_102)
2013/05/24 11:27:54 net.dependableos. dcase. diagram *** update status process end. #%*

3.4.7. Checking and evaluating the result of a benchmark scenario
A result is displayed automatically after performing a benchmark scenario.

When the benchmark scenario ends, an Evidence node will be created automatically.

Lan sacisry sLA

A strategy:s_40
Argue over benchmarks

O GoakG_102 —

Benchmark by HttperfThis benchmark accesses O Goal:G_68
the Web server 42 times a second until the Access counts can be monit
number of accesses reaches 2500.1t evaluate...

finish(success) 100 %

(i MonitorM_11
Monitor at the entrv t...

ResponseTime(ms):<3000(51.2)

T

The result of the comparison parameter set in the Evidence node is displayed.

A value of an execution result is shown in parentheses.
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The expected value set as the goal is "3 seconds maximum response time of httperf is (3000 milliseconds)

less than" and the result is "588.8 miIIiseconds"._Therefore this result satisfies the condition.

*1f the result does not meet the expected value, an “Undeveloped” red node is added.

El L Indeveloped:U_1

*The detailed DS-Bench scenario execution results can be displayed in D-Case Editor.

Follow the links Right-click the Evidence node > Attachment > Open

* B ) *Tutorialo4.dcase_diagram @ D-Case External File 2

- ® & heepy Jegi-binfview_result_detail.ogitview_id=461
se_div
. Dependable Embedded
- rating|Systams’
- DS-Bench o hummme
Time Scale : b—i| 0/:| 0] :|10 f———Total : 000:01:40 | Auto Adjust

0:00 000:00:50 000:01:40
 target-img-20- _:
m1.tiny.00

Add Target

Target list
Add Tags | Current Tags:

Add Viewer
Mame ResultName  Description

¥ Response Time(ms) $(reduction:max:HttperfTtotal) |[Max

» Run Stop New Load Save

If the measurement results of the Benchmark tool need to be used as Evidence at the time of D-Case
creation, DS-Bench is used in coordination with D-Case Editor or D-Case Weaver, which validates the
results. It is judged whether the execution results fulfill the expected value.

When the execution result matches the expected value, the contents of the scenario are validated.
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